
uSDX transceiver   menu_versie c 2 
 

HF     80  –  6 meter   Snel gids 

 

SW1 / L button:  Select 
kort indrukken: Selecteer menu 
indrukken & encoder draaien: snel door menu’s 
dubbel indrukken: ----- 
langer indrukken: ----- 
 

SW2 / R button:  Exit 
indrukken: mode:  CW / LSB / USB   ///   na een keuze:  Exit  menu 
dubbel indrukken: veranderen instelling reeks Filter BW   (menu 1.3) :   4000 / 2500 / 1700 / Full 
langer indrukken: wisselen tussen  R  (receive)   en    V  (vox) 
 

SW Rotary encoder:  
kort indrukken: decimaal verstelling bij tunen  naar rechts   ///   bevestiging selectie keuze 
langer indrukken: decimaal verstelling bij tunen  naar links  
dubbel indrukken: band wissel:  3,573 / 5,357 / 7,074 / 10,136 / 14,074 / 18,100 / 21,074 / 24,915 / 28,074 / 50,313  MHz 

indrukken & draaien: veranderen instelling Volume   (menu 1.1)    harder / zachter 
 

Rotary encoder:   Tune  VFO 
Na SW1 - Select:  menu: bereik: 1e keer drukken: wijzigen; 2e keer drukken: keuze opslaan. 
1.1 Volume (10) [  -1 / 0  – 16 ] 
1.2 Mode (USB) [ CW / USB / LSB / FM / AM ] 
1.3 Filter BW (Full) [ 50 / 100 / 200 / 500 / 1700 / 2500 / 4000 / Full ] 
1.4 Band (20m) [ 6m / 10m / 12m / 15m / 17m / 20m / 30m / 40m / 60m / 80m ] 
1.5 Tune Rate (1k) [ 1 / 10 / 100 / 0,5k / 1kHz / 10 kHz / 100k / 0,5M / 1M / 10M ] 
1.6 AGC (ON) [ ON / OFF ] 
1.7 NR (0) [ 0 – 8 ] 
1.8 ATT (0dB) [ 0dB / -13dB / -20dB / -33dB / -40dB / -53dB / -60dB / -73dB ] 
1.9 ATT2 (0) [ 0 – 16 ] 
1.10 S-meter (dBm) [S-bar / S / dBm / OFF ] 
 

2.1 CW Decoder (OFF) [ ON / OFF ] 
2.2 CW Tone (700) [ 325 / 700 ] 
2.3 CW Offset (700) [ 300 – 2000 ] 
 

3.1 VOX (OFF) [ ON / OFF ] 
3.2 VOX Level (4) [ 0 – 255 ] 
3.3 MOX (0) [ 0 – 4 ] 
2.4 TX Drive (4) [ 0 – 8 ] 
 

8.1 Ref freq (25000000) [ 
8.2 PA Bias min (0) [ 0 – 255 ] 
8.3 PA Bias max (220) [ 0 – 255 ] 
 

9.1 Sample rate (+0) [ 
9.2 CPU load % (+0)` [ 
9.3 Param A (0) [ 
9.4 Param B (+0) [ 
9.5 Param C (+0) [ 
 

AJB, pe1htj  Vlaardingen, 20201126 
-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=-=- 



Bron van de hierna volgende beschrijving:    https://github.com/threeme3/QCX-SSB 
 

Gebruiksaanwijzing: 
De afstemming kan worden gedaan door het verdraaien van de roterende encoder.  
De stapgrootte kan worden verlaagd of verhoogd met een korte of lange druk op de schakelaar.  
Een verandering van band kan worden gedaan met een dubbele druk.  
De werkingswijze wordt met een korte druk op de rechterknop gestopt.  
Een dubbele druk op de rechter knop veranderd de bandbreedte van het ontvangstfilter, de bandbreedte wordt elke keer 
opnieuw ingesteld wanneer de modus wordt gewijzigd.  
Het volume wordt veranderd door de roterende encoder te draaien terwijl u erop drukt. 
Er is een menu beschikbaar dat toegankelijk is via een korte druk op de linker drukknop.  
Met de roterende encoder is het mogelijk door dit menu te navigeren.  
Wanneer u een menu-parameter wilt wijzigen drukt u op de linker drukknop om vervolgens de parameter met de encoder te 
wijzigen.  
Met de rechter drukknop is het mogelijk om het menu op elk gewenst moment te verlaten.  
Een snelle toegang tot het menu en de parameters kan worden bereikt door op de linker knop te drukken terwijl u de encoder 
draait; zodra u de linker knop los laat kunt u de parameter onmiddellijk wijzigen door verdraaien van de encoder. 
Voor ontvangst is standaard een AGC ingeschakeld. Dit verhoogt het volume wanneer er zwakke signalen en vermindert voor 
sterke signalen. Dit is goed voor SSB signalen, maar kan vervelend zijn voor CW operatie.  
De AGC kan worden uitgeschakeld in het menu, dit maakt de ontvanger minder luidruchtig, maar vereisen meer handmatige 
volume wijzigingen.  
Om het geluid verder te verminderen kan een ruisonderdrukkingsfunctie in het menu met de NR-parameter worden 
ingeschakeld.  
Om het beschikbare dynamische bereik optimaal te gebruiken kunt u binnenkomend signaal verzachten door een front-end 
attenuator in te schakelen met de parameter ATT. Vooral op frequenties 3,5 - 7 MHz zijn de atmosferische geluidsniveaus veel 
hoger, u kunt de prestaties van de ontvanger verhogen door demping (bijvoorbeeld -13dB) toe te voegen, zodat de 
geluidsvloer nog steeds hoorbaar is.  
Om de transceiver-frequentie te kalibreren kunt u afstemmen op een gekalibreerde signaalbron (bijvoorbeeld WWV op 10 
MHz) en het signaal zero-beat door de parameter Ref freq te wijzigen; als alternatief kunt u de XTal-frequentie meten met 
een teller en de parameter instellen.  
Een S-meter (naar keuze: dBm, S, S-bar) kan worden geselecteerd met de parameter S-meter. Als u S-bar kiest, wordt een 
signaalsterktebalk weergegeven waarbij elke ‘bar’  één S-punt (6dB) vertegenwoordigt. 
Voor SSB gebruik: sluit een microfoon aan op de paddle-aansluiting en een PTT of onboard "key" zal de transceiver op Zenden 
zetten.  
Met de parameter "TX Drive" is het mogelijk om de modulatiediepte of PA-schijf in te stellen. Het is standaard ingesteld op 4, 
waardoor het een beetje meer punch geeft (compressie voor SSB). Instellen op een waarde 8 in SSB betekent dat de SSB 
modulatie wordt verzonden met een constante amplitude (mogelijk het verminderen van RFI, maar gaat ten koste van de 
audiokwaliteit). Om uw eigen modulatie te controleren kunt u de parameter MOX tijdelijk verhogen.  
Een lange druk op de rechter drukknop zet de transceiver in de VOX-mode. De gevoeligheid van de VOX kan worden ingesteld 
in de parameter "VOX-drempelwaarde". 
De PA Bias min en max parameters stelt het werkbereik van de PWM in, volledige bereik is van 0-255. Het optimale 
werkbereik ligt net boven de MOSFET drempel tot het maximale piekvermogen dat u wilt gebruiken (0-180 zijn goede 
waarden op mijn QCX). 
Voor FT8 (en elke andere digitale mode) selecteert u één van de voorgeprogrammeerde FT8-banden door dubbel op de 
roterende encoder te drukken. Sluit de hoofdtelefoonaansluiting aan op de microfoon ingang van de geluidskaart van de 
computer/laptop, de luidsprekeraansluiting aan de microfoon-ingang en geef een lange druk op de rechter drukknop om de 
VOX-modus te starten. Pas het volume zo min mogelijk aan en start uw favoriete FT8-toepassing (bijvoorbeeld JTDX).  
Bij het opstarten voert de transceiver een zelftest uit waarbij ook het programma versie nummer wordt getoond. Het is het 
controleren van de software-instellingen, zoals bias voltages, I2C communicatie en algoritmische prestaties. In het geval van 
afwijkingen meldt het display een fout tijdens het opstarten. Het ontdekt ook de mogelijkheden van de transceiver, 
afhankelijk van de gemaakte mod’s.  
De volgende mogelijkheden worden gedetecteerd en weergegeven op het scherm:  

"QCX" voor een QCX zonder mod’s;  
"QCX-SSB" voor een QCX met SSB mod;  
"QCX-DSP" voor een QCX met SIDETONE losgekoppeld en aangesloten op een luidspreker (door 

ontkoppelingscondensator);  
"QCX-SDR" voor een QCX met SDR mod.  
“uSDX>” voor een uSDX met SSB mod. 

Controleer of de deze mogelijkheid overeenkomt met de mod’s. 
 

https://github.com/threeme3/QCX-SSB


Bewerking: 
Momenteel zijn de volgende functies toegewezen aan sneltoetsknoppen (L=links, E=encoder, R=rechts) en menu-items: 
 
Menu-item Functie Knop 

1.1  Volume Audio-niveau (0..16) en uit-/uitschakelen/aan E +turn 
1.2  Modus Modulatie (LSB, USB, CW, AM, FM) R 
1.3  Filter BW Audio passband (Vol, 300..4000, 300..2500, 300..1700, 200, 100 Hz) R dubbel 
1.4  Band Band-switch naar vooraf gedefinieerde FT8 freqs: (80 t/m 4m) E dubbel 
1.5  Tuning rate Tuning stapgrootte (10M, 1M, 0.5M, 100k, 10k, 1k, 0.5k, 100, 10, 1) E kort of E langer 
1.6  AGC Automatische gaincontrole (aan, uit) 
1.7  NR Ruisonderdrukkingsniveau (0-8), load-pass en glad 
1.8  ATT Analoge attenuator (0, -13, -20, -33, -40, -53, -60, -73 dB) 
1.9  ATT2 Digitale attenuator in CIC-fase (0-16) in stappen van 6dB 
1.10  S-meter Type S-meter (UIT, dBm, S, S-bar) 
2.1  CW Decoder CW-decoder in- of uitschakelen (AAN, UIT) 
2.2  CW Toon CW-filter+zijtoon (325, 700) 
2.3  CW Offset CW RX Offset (gebruiken om uit te lijnen met CW-filtertoon) 
3.1  VOX Voice Operated Xmit (AAN, UIT) 
3.2  VOX-niveau Audiodrempel van VOX (0-255) 
3.3  MOX Monitor op Xmit (audio niet gedempt tijdens het verzenden) 
3.4  TX-schijf Audio gain (0-8) verzenden in stappen van 6dB, 8=constante amplitude voor SSB 
8.1  Ref freq Werkelijke si5351 kristalfrequentie, gebruikt voor frequentiekalibratie 
8.2  PA Bias min KEY_OUT PWM-niveau (0-255) voor 0% RF-output 
8.3  PA Bias max KEY_OUT PWM-niveau (0-255) voor 100% RF-output 
9.1  Steekproef % voor foutopsporing, testen en experimenteel doel 
9.2  CPU-belasting voor foutopsporing, testen en experimenteel doel 
9.3  Param A voor foutopsporing, testen en experimenteel doel 
9.4  Param B voor foutopsporing, testen en experimenteel doel 
9.5  Param C voor foutopsporing, testen en experimenteel doel 
 
Belangrijk: Frequentie (20kHz.. 99 MHz) draai 
Belangrijk: Snel menu L + draai 
Belangrijk: Menu-enter L 
Belangrijk: Menu terug R 
 
 

 
  



README.md 
 

QCX-SSB:      SSB met uw QCX-transceiver 
Dit is een eenvoudige en experimentele wijziging die een QCX omzet in een (Klasse-E gedreven) SSB transceiver. 
Het kan worden gebruikt om QRP SSB-contacten te maken, of (in combinatie met een pc) die worden gebruikt 
voor de digitale modi zoals FT8, JS8, FT4. Het kan volledig continu worden afgestemd door middel van banden 
80m-10m in de LSB / USB-modi met een 2400Hz bandbreedte heeft tot 5W PEP SSB output en beschikt over een 
software-gebaseerde volledige Break-In VOX voor snelle RX / TX schakelen in spraak-en digitale bewerkingen. 
De SSB-zendfase wordt volledig op digitale en software gebaseerde wijze geïmplementeerd: in het hart 
bemonstert de ATMEGA328P de input-audio en reconstrueert een SSB-signaal door de SI5351 PLL-fase te regelen 
(door kleine frequentiewijzigingen van meer dan 800kbit/s I2C) en de PA Power (via PWM op het key-shaping 
circuit) te regelen. Op deze manier kan een zeer energiezuinig klasse-E aangedreven SSB-signaal gerealiseerd 
worden; een PWM aangedreven klasse-E ontwerp houdt de SSB transceiver eenvoudig, klein, koel, energiezuinig 
en goedkoop (d.w.z. geen behoefte aan energie-inefficiënte en complexe lineaire versterker met omvangrijke 
koellichaam zoals vaak wordt gezien in SSB transceivers). 
Voor de ontvanger is een groot deel van het originele QCX-circuit digitaal verwijderd en geïmplementeerd 
(software): de ATMEGA328P implementeert nu het 90-graden faseverschuivingscircuit, het (CW/SSB) filtercircuit 
en het audioversterkercircuit (nu een klasse-D versterker). Dit heeft het QCX-circuit veel vereenvoudigd (50% 
minder componenten nodig), en er zijn een aantal voordelen en functies: er is geen behoefte meer aan een 
uitlijningsprocedure vanwege de zeer nauwkeurige 90 graden Hilbert-faseshifter; en er zijn nu verstelbare IF DSP-
filters voor CW en SSB; en er is een AGC en er is een ruis-reducerende DSP signaal conditionering functie en er zijn 
drie indepent ingebouwde attenuatoren in de analoge front-end die helpt gebruik te maken van het volledige 
dynamische bereik. De luidspreker is direct verbonden en aangedreven door de ATMEGA. Een digitale mixer met 
smalle low-pass venster (2 kHz), steile roll-off (-45dB/decennium) in combinatie met een oversampling en 
decimeren ADC zijn verantwoordelijk voor een verwerking winst, dynamisch bereik en alias afwijzing voldoende 
om zwakke en sterke signaal omstandigheden (bijvoorbeeld wedstrijden of luisteren op 40m net naast de omroep 
band). 
Dit experiment is gemaakt om uit te proberen wat kan worden bereikt met minimale hardware, terwijl het 
verplaatsen van complexiteit in de richting van software; hier de gevolgde aanpak is om het ontwerp te 
vereenvoudigen waar mogelijk, terwijl een redelijke prestatie te houden. Het resultaat is een goedkope, 
eenvoudig te bouwen, veelzijdige QRP SSB-zendontvanger die eigenlijk heel geschikt is voor het maken van QSOs 
(zelfs in wedstrijdsituaties), maar vanwege het experimentele karakter zijn sommige onderdelen nog in uitvoering 
en dus beperkt.  
Voel je vrij om het uit te proberen of om te experimenteren met deze schets, laat me weten wat je gedachten of 
bijdragen hier: https://github.com/threeme3/QCX-SSB De oorspronkelijke forum discussie over het onderwerp 
hier: QRPLabs Forum 
 

Update: Een nieuwe groep met gezamenlijke interesse is begonnen met het bouwen van een compacte, 
draagbare (SOTA) rig voor de zomer, op basis van de ideeën hier gepresenteerd. Meer informatie is te vinden in 
dit: Forum. 
 

73, Guido pe1nnz@amsat.org 
 

 

https://qrp-labs.com/qcx.html
https://github.com/threeme3/QCX-SSB
https://groups.io/g/QRPLabs/topic/29572792
https://groups.io/g/ucx
mailto:pe1nnz@amsat.org
https://github.com/threeme3/QCX-SSB/blob/master/top.png


Lijst met functies: 
Eenvoudige, leuke en veelzijdige QRP SSB HF-transceiver met ingebouwde DSP- en SDR-functies; 
EER Class-E aangedreven SSB-zendfase 
Ongeveer 5W PEP SSB output van 13.8V voeding 
Ondersteuning voor all-mode: USB, LSB, experimentele modi: CW, AM, FM 
DSP-filters: 4000, 2500, 1700, 500, 200, 100, 50 Hz passband 
DSP-functies: Automatic Gain Control (AGC), Noise-reduction (NR), Voice-triggered Xmit (VOX), RX Attentuators 
(ATT), TX drive control, Volume control, dBm/S-meter. 
SSB tegenover side-band/carrier supression Transmit: beter dan -45dBc, IMD3 (two-tone) -33dBc, Ontvangen: 
beter dan -50dBc 
Multiband ondersteuning, continu tunable via banden 80m-10m (en vanaf 20kHz.. 99MHz met prestatieverlies) 
Open source firmware, gebouwd met Arduino IDE; maakt experimenteren mogelijk, nieuwe functies kunnen 
worden toegevoegd, bijdragen kunnen worden gedeeld via Github, software-complexiteit: 2000 regels code 
Softwaregebaseerde VOX die kan worden gebruikt als snelle Full Break-In (QSK-werking) of helpen bij het 
schakelen tussen RX/TX voor het bedienen van digitale modi (geen CAT- of PTT-interface vereist) 
Eenvoudig te installeren modificatie met 8 component wijzigingen en 8 draden 
Lichtgewicht en goedkope transceiver ontwerp: vanwege de EER-zender klasse-E fase is het zeer 
energiezuinig (geen omvangrijke heatsinks vereist), en heeft een eenvoudig ontwerp (geen complexe 
evenwichtige lineaire eindversterker vereist) 
Volledig digitaal en softwarematig ssb-zendfase: samples microfoon-input en reconstrueren van een SSB-signaal 
door het regelen van de fase van de SI5351 PLL (door kleine frequentieveranderingen van meer dan 800kbits/s 
I2C) en de amplitude van de PA (via PWM van het PA key-shaping circuit) 
Volledig digitale en softwarematige SDR receiver-stages (optioneel): samples I/Q (complex) signaal van 
Quadrature Sampling Detector digitale mixer, en voert een 90-graden fase-shift mathemaly in software (Hilbert-
transform) en annuleert een side-band door ze toe te voegen 
Drie onafhankelijke schakelbare analoge front-end receiver attenuatoren (0dB, -13dB, -20dB, -33dB, -53dB, -
60dB, -73dB) 
Receiver Noise floor MDS: –135 dBm at 28MHz (in 200Hz BW) 
Ontvanger Front-end selectiviteit: steil -45dB/decade roll-off +/-2kHz vanaf de afgestelde frequentie 
Dynamisch bereik blokkeren: 20kHz offset 123dB, 2kHz offset 78dB 
CW-decoder (experimenteel). 
Waarschijnlijk de meest kosteneffectieve en eenvoudig te bouwen standalone SDR / SSB transceiver die je vinden. 
Vereenvoudigt het originele QCX-circuit (d.w.z. 50% minder componenten te installeren, geen complexe 
transformatorwikkelingen, geen uitlijningsprocedure)en veelzijdiger in gebruik. 
 
Revisiegeschiedenis: 

Rev. Datum Functies 

R1.02 
(huidig) 

2020-
04-12 

Geïntegreerde SDR-ontvanger, CW-decoder, DSP-filters, AGC, NR, ATT, experimentele 
modi CW, AM, FM, snel menu, permanente instellingen, verbeterde SSB TX-kwaliteit. 
LCD fix, selecteerbare CW pitch. 

R1.01d 
2019-
05-05 

Q6 nu digitaal geschakeld (verwijder C31) - verbetering van de stabiliteit en IMD. 
Verbeterde signaalverwerking, audiokwaliteit, verhoogde bandbreedte, cosmetische 
veranderingen en minder RF-feedback, verminderde S-meter RFI, S-meter metingen, 
zelftest bij het opstarten. Ontvanger I/Q kalibratie, (experimentele) amplitude pre-
distortion en kalibratie. Zie hier originele QCX-SSB wijziging (het wordt ook 
ondersteund door de huidige firmware!) 

R1.00 
2019-
01-29 

Eerste release van SSB transceiver prototype. 

Schematische: 
Onder het schema na de wijziging is toegepast, worden ongebruikte onderdelen weggelaten en worden gewijzigde 
onderdelen rood gemarkeerd (klik om in te zoomen en downloaden) (link naar het oorspronkelijke schema):   
 

https://github.com/threeme3/QCX-SSB/blob/master/ucx.png
https://core.ac.uk/download/pdf/148657773.pdf
https://github.com/threeme3/QCX-SSB/tree/R1.01d
https://qrp-labs.com/images/qcx/HiRes.png


 
 
Vindt u hier de nieuwste PCB Rev5 Assembly Manual KLIK HIER door Manuel, DL2MAN (document revisie 1.1), 
23-mei-2020. Instructie voor oudere PCB revisies vindt u hieronder: 
Deze wijziging bestaat uit een paar component veranderingen en draden: 
Om dingen te vereenvoudigen, 79 componenten zijn niet meer nodig (en je kon ze weglaten op een niet-
gebouwde QCX): IC6-10,R11-40,43,55,R59-64,C1,5,8,C9-28,C31,C52-54,L1-3,D5,Q7,T1,JP1/DVM/FREQ. 
SDR-ontvanger: R7,10(82k); C4,C7(1nF), verwijder R11,12,14,15,17,27,29,59,IC10; plaats 10nF tussen IC10 pin 2 en 
pin 4; wire IC2(pin15) to IC10(pin1), insert 470R if you intend to use a headphones; draad C39(R27/R29zijde) naar 
IC5(pin1); C40(IC10-zijde) naar IC5(pin7) en koppel R50(5V-zijde) en R52(5V-zijde) en draad beide af op IC2(pin21). 
Als u C39,R50 niet bedraden, maak dan de volgende Rev5-mods: verwijder IC7, verander R11(.1uF), C9(10k), 
R53(1k); draad 10k van R52(IC2-pin21 kant) naar IC7(pin5); draad R11 (C9 kant) naar R27 (midden). Als u de 
originele (analoge) QCX-ontvanger wilt opbouwen, u deze stap overslaan en een SPDT-switch invoegen tussen 
C21(+ kant) en IC9(pin1) voor CW en R27(pin2) voor SSB (zoals gebeurde in de oorspronkelijke QCX-SSB-
modificatie). 
SSB zender: wissel D4,R56 (10k); R58 (.22uF); C32 (10uF), verwijder C31; wire IC2(pin21) to pin R57(side DVM-
pin3); wire IC2(pin20) naar DVM(pin2); draad IC2(pin18) naar knooppunt D4-C42-R58; installeer een microfoon om 
te tippen (+ van electret) en mouw GND van paddle-jack; PTT-switch naar ring en mouw(X1M-mic). 
Multibandondersteuning: verwijder C1,5,8,R64,T1; bij T1 landingspatroon (zie QCX Assembly instructie T1) 
installeer R (1k) meer dan 6-8; R (1k) over 3-4; C (10nF) meer dan 4-8; C30 (30pF) wijzigen; L4 (1uH/16t); C25-
28,L1-L3 vervangen door LPF's voor verschillende banden. 
Firmware: download recentelijk vrijgegeven hex-bestand en installeer met standaard QCX firmware 
uploadprocedure (zie ook noot 1). 
Hieronder de (Rev4) lay-out met componenten gemarkeerd in het rood die moeten worden gewijzigd; grijze 
componenten moeten worden geïnstalleerd en lege onderdelen kunnen worden weggelaten en sommige moeten 
worden verwijderd (zie hierboven): 
 

https://github.com/threeme3/QCX-SSB/blob/master/QCX-SSB_assembly_Rev-5.pdf
https://github.com/threeme3/QCX-SSB/tree/R1.01d
https://github.com/threeme3/QCX-SSB/tree/R1.01d
https://vignette.wikia.nocookie.net/x1m/images/f/f1/X1M_mic_pinout_diagram.jpg/revision/latest?cb=20131028014710
https://www.qrp-labs.com/images/qcx/assembly_A4_Rev_4b.pdf
https://github.com/threeme3/QCX-SSB/releases
https://www.qrp-labs.com/qcx/qcxfirmware.html
https://www.qrp-labs.com/qcx/qcxfirmware.html
https://github.com/threeme3/QCX-SSB#note1
https://github.com/threeme3/QCX-SSB/blob/master/schematic.png


  
 
Onder de (Rev4) draden die moeten worden geïnstalleerd op de onderste PCB. Merk op dat een cirkel weerstand 
R50/R52 vertegenwoordigt die in serie met de draad en het stootkussen is waarop de cirkel wordt getrokken (de 
weerstand is niet meer verbonden aan zijn originele naburige stootkussen en zijn waarschijnlijk het beste om deze 
bedrading en weerstand bij de componentenkant te plaatsen): 

https://github.com/threeme3/QCX-SSB/blob/master/layout.png


  
Zie hier de voltooide transceiver met de (Rev4) wijzigingen toegepast (inclusief PA bias mod note 3, omvat geen 
LPF's):  
 

  

https://github.com/threeme3/QCX-SSB#note3
https://github.com/threeme3/QCX-SSB/blob/master/pcb.png
https://github.com/threeme3/QCX-SSB/blob/master/pcb-top.png


 
 
Bouwopties: 
Voor een ongebouwde QCX, de makkelijkste manier om deze digitale transceiver te bouwen is om de 79 
componenten weg te laten en alle bovenstaande wijzigingen toe te passen, zal dit u alle hierboven beschreven 
functies bieden. Als u wilt, u nog steeds besluiten om de originele QCX vanaf hier te bouwen. 
Als u al een werkende QCX, de makkelijkste manier is om de SSB verzenden mod toe te passen en omzeilen de 
CW-filter met een schakelaar, op deze manier uw transceiver houdt de analoge ontvanger circuit, zijn er geen SDR-
functies, en je nog steeds de originele QRP Labs CW firmware als je dat liever. 
 
 
 
 
 
  

https://github.com/threeme3/QCX-SSB/blob/master/pcb-bottom.png


Technical Description: 
 
The principle of operation (at least what is ging on in the ATMEGA) is a bit as in the following video-fragment: Opzij (in Dutch 
saying; "Sideways, sideways, sideways, Make room, make room, make room, We are in an incredible rush"; full lyrics) here... :-
) jokes aside; below the block diagram of the QCX-SSB, SDR transceiver: 

  
For SSB reception, the QCX analog phasing receiver stage is replaced with a digital SDR stage; this means that the phase 
shifting op-amp IC6 is changed into a regular amplifier and whereby the individual I and Q outputs are directly fed into the 
ATMEGA328P ADC inputs for signal processing. The ATMEGA328P (over-)samples the ADC input at a 62kHz sample-rate, an 
decimates this high-samplerate to a lower samplerate, performs a phase-shift by means of a Hilbert-transform, summing the 
result to obtain side-band rejection; it subsequently applies a low-pass filtering, AGC and noise-reduction functions. Since the 
original QCX phase-shifting network and analog CW filter are not used, about half of the original QCX components can be left 
out; by combining the function of IC7B into IC6A another op-amp can be saved. The ADC inputs are low-pass filtered (-
40dB/decade roll-off at 1.5kHz cut-off) to prevent aliasing and input are biased with a 1.1V analog reference voltage to obtain 
additional sensitivity and dynamic range. With the 10-bit ADCs and a 4x over-sampling rate, a theoretical dynamic range of 
72dB can be obtained in 2.4kHz SSB bandwidth. LSB/USB mode switching is done by changing the 90 degree phase shift on 
the CLK0/CLK1 signals of the SI5351 PLL. Three embedded attenuators are available for optimally using dynamic range; the 
first attenuator is the RX MOSFET switch Q6 responsible for 20dB attenuation, the second attenuator is ADC range (1.1V or 
5V) selected by the ATMEGA ADC analog reference (AREF) logic and is responsible for 13dB attenation, the third attenuator is 
a pull-down of an analog input on the ATMEGA with a GPIO port responsible for 53dB attenation. Combining the three 
attenuators provides the attenation steps 0dB, -13dB, -20dB, -33dB, -53dB, -60dB, -73dB. 
For SSB transmission the QCX DVM-circuitry is changed and used as an audio-input circuit. An electret-microphone (with PTT 
switch) is added to the Paddle jack connecting the DVM-circuitry, whereby the DOT input acts as the PTT and the DASH input 
acts as the audio-input. The electret microphone is biased with 5V through a 10K resistor. A 10nF blocking capacitor prevents 
RF leakage into the circuit. The audio is fed into ADC2 input of the ATMEGA328P microprocessor through a 220nF decoupling 
capacitor. The ADC2 input is biased at 0.55V via a divider network of 10K to a 1.1V analog reference voltage, with 10-bits ADC 
resolution this means the microphone-input sensitivity is about 1mV (1.1V/1024) which is just sufficient to process 
unamplified speech. 
A new QCX-SSB firmware is uploaded to the ATMEGA328P, and facilitates a digital SSB generation technique in a completely 
software-based manner. A DSP algorithm samples the ADC2 audio-input at a rate of 4x4800 samples/s, performs a Hilbert 
transformation and determines the phase and amplitude of the complex-signal; the phase-changes are restrictednote 2 and 
transformed into either positive (for USB) or negative (for LSB) phase changes which in turn transformed into temporary 
frequency changes which are sent 4800 times per second over 800kbit/s I2C towards the SI5351 PLL. This result in phase 
changes on the SSB carrier signal and delivers a SSB-signal with a bandwidth of 2400 Hz whereby spurious in the opposite 
side-band components is attenuated. 
The amplitude of the complex-signal controls the supply-voltage of the PA, and thus the envelope of the SSB-signal. The key-
shaping circuit is controlled with a 32kHz PWM signal, which can control the PA voltage from 0 to about 12V in 256 steps, 
providing a dynamic range of (log2(256) * 6 =) 48dB in the SSB signal. C31 is removed to ensure that Q6 is operating as a 
digital switch, this improves the efficiency, thermal stability, linearity, dynamic range and response-time. Though the 
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amplitude information is not mandatory to make a SSB signal intelligable, adding amplitude information improves quality. The 
complex-amplitude is also used in VOX-mode to determine when RX and TX transitions are supposed to be made. Instead of 
using a key-shaping circuit for evelope control, it is possible to directly bias the PA MOSFETs with the (filtered) PWM signal. 
This has the advantage of less losses and simplifies at the cost of linearity which result in more compression for an SSB signal 
(which is actually a good thing). 
The IMD performance is related dependent on the quality of the system: the linearity (accuracy) of the amplitude and phase 
response and the precision (dynamic range) of these quantities. Especially the DSP bit-width, the precision used in the DSP 
algorithms, the PWM and key-shaping circuit that supplies the PA and the PA phase response are critical. Decreasing (or 
removing) C32 improves the IMD characteristics but at the cost of an increase of PWM products around the carrier. 
 
Results 
Here is a sample me calling CQ on 40m with my QCX-SSB at 5W and received back by the Hack Green websdr about 400km 
away, note that the audio quality has further improved since then. 
Several OMs reported a successful QCX-SSB modification and were able to make SSB QRP DX contacts over thousands of 
kilometers on the 20m and 40m bands. During CQ WW contest I was able to make 34 random QSOs on 40m with 5W and an 
inverted-V over the house in just a few hours with CN3A as my furthest contact, I could observe the benefits of using SSB with 
constant-envelope in cases where my signal was weak; for FT8 a Raspberry Pi 3B+ with JTDX was used to make FT8 contacts 
all the way up to NA. 
Measurements: The following performance measurements were made with QCX-SSB R1.01, a modified RTL-SDR, Spektrum-
SVmod-v0.19, Sweex 5.0 USB Audio device and Audicity player. It is recognized that this measurement setup has its own 
limitations, hence the dynamic range of the measurements is somewhat limited by the RTL-SDR as this device goes easily into 
overload. Measurements were made with the following setttings: USB modulation, no pre-distortion, two-tone input 
1000Hz/1200Hz where audio level is set just before the point where compression starts.  
 
Results: 
Intermodulation distortion products (two-tone; SSB with varying envelope) IMD3, IMD5, IMD7: respectively -33dBc; -36dBc; -
39dBc 
Intermodulation distortion products (two-tone; SSB with constant envelope) IMD3, IMD5, IMD7: respectively -16dBc; -16dBc; 
-19dBc 
Opposite side-band rejection (two-tone): better than -45dBc 
Carrier rejection (two-tone): better than -45dBc 
Wide-band spurious (two-tone): better than -45dBc 
3dB bandwidth (sweep): 0..2400Hz 
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Notes: 
Firmware upload variations: 
AVRDudess tool or avrdude CLI (avrdude -c avrisp -b 19200 -P /dev/ttyACM0 (or: /dev/ttyUSB0) -p m328p -e -U 
efuse:w:0xFD:m -U hfuse:w:0xD6:m -U lfuse:w:0xFF:m -U flash:w:R1.0x.hex) can be used for uploading the firmware via the 
ISP connector on the QCX. Follow Arduino as ISP instructions if you have a Arduino UNO board available (tip: use female-to-
male breadboard cables to connect Arduino to QCX ISP jumper); or USBasp instructions if you have a USBasp programmer, 
alternatively use USPasp ExtremeBurner; but many other ISP programmers can be used in similar manner such as USBtiny or 
AVRisp mkII. During ISP, mic should be disconnected, power supply should be connected; in tool do not erase, program 
EEPROM or set fuse settings (they are by default ok: E=FD H=D6 L=FF). 
Alternatively, in case you have an ATMEGA328P chip with Arduino bootloader, you can place the chip in an Arduino UNO 
board and upload directly (without the need for a ISP cable and QCX) by specifying 'arduino' programmer and baudrate 
115200. 
Alternatively, in case you have an Arduino 1.8.9 (or newer) environment installed, you can upload the QCX-SSB Sketch directly 
from the Arduino environment (without using AVRDudess and firmware file); make sure "Tools > Board > Arduino/Genuino 
Uno", "Tools > Port > /dev/ttyUSB0 or ttyACM0", and then "Sketch > Upload" is selected, while the ATMEGA328P chip is 
placed in the Arduino UNO socket. It is also possible to use Arduino as ISP method: upload this variation of ArduinoISP to the 
Arduino board and select "Tools > Programmer > Arduino as ISP", and "Sketch > Upload Using Programmer". 
The occupied SSB bandwidth can be further reduced by restricting the maximum phase change (set MAX_DP to half a unit-
circle _UA/2 (equivalent to 180 degrees)). Audio-input can be attenuated by increasing parameter MIC_ATTEN (6dB per step). 
Alternatively, the PA MOSFETs can be directly biased by the PWM envelope signal, basically making the key-shaping circuit 
redundant. To do so, Q6,Q4,R41,R42,C32,C31 can be removed entirely, whereby C-E pads of Q6 are wired, and where a 10nF 
capacitor is inserted at IC3A-pin3 and G of Q1-3, and where a 10k resistor is placed at G-D pads of Q4, a 10nF capacitor 
between S-D pads of Q4, and where a 10k resistor is placed between D of Q4 and G of Q1-3. 
 
Credits: 
QCX (QRP Labs CW Xcvr) is a kit designed by Hans Summers (G0UPL), originally built for RSGB's YOTA summer camp 2017, a 
high performance, image rejecting DC transceiver; basically a simplified implementation of the NorCal 2030 by Dan Tayloe 
(N7VE) designed in 2004 combined with a Hi-Per-Mite Active Audio CW Filter by David Cripe (NMØS), Low Pass Filters from Ed 
(W3NQN) 1983 Articles, a key-shaping circuit by Donald Huff (W6JL), a BS170 switched CMOS driven MOSFET PA architecture 
as used in the ATS designs by Steven Weber (KD1JV) (originating from the Power MOSFET revolution in the mid 70s), a Ghetto-
class-E filter-network published by Paul Harden (NA5N) and an Atmel ATMEGA328P microprocessor, a Hitachi HD44780 LCD 
display and a Silicon Labs SI5351 Clock Generator (and using a phase shift in the SI5351 clocks). The QCX-SSB transmitter and 
QCX-SDR receiver stage both running on a ATMEGA328P, including its multiband front-end and direct PA biasing/envelope-
generation technique; its concept, circuit, code and modification to run on a QCX are a design by Guido (PE1NNZ); the 
software-based SSB transmit stage is a derivate of earlier experiments with a digital SSB generation technique on a Raspberry 
Pi. The assembly manual for the QCX Rev 5 PCB, is the work of Manuel (DL2MAN). Many thanks to all of you who got 
interested in this project and took the challege and effort to try out QCX-SSB. Without your valuable feedback and 
contributions the project could not have kept moving on, improving and challenging new ideas! 
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